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Related Manuals

To ensure system safety, always read and follow the information provided in all Safety
Precautions and Precautions for Safe Use in the manuals for the devices that are used in the
system.

The following shows the manuals for OMRON Corporation (hereafter referred to as OMRON)
and Delta Tau Data Systems, Inc (DT).

Manufacturer | Manual No. Model Manual name

OMRON 1610-E1 Model CK3E-LIOIO Programmable Multi-Axis Controller
Hardware User’s Manual

OMRON W580-E1 Model NY510J-AJO0O | Industrial PC Platform NY-series IPC

Programmable Multi-Axis Controller
Hardware User’s Manual

OMRON Z332-E1 Model ZW-CE10] ZW-CE1[] Confocal Fiber Type
Displacement Sensor User’s Manual

DT 0014-E - Power PMAC User’s Manual

DT 0015-E - Power PMAC Software Reference
Manual

DT 0016-E - Power PMAC IDE Users Manual




2. Terms and Definitions

Term Explanation and Definition
Slave Slaves are devices connected to EtherCAT. There are various types of
slaves such as servo drivers handling position data and 1/O terminals
handling the bit signals.
Object Represents information such as in-slave data and parameters.
PDO One type of EtherCAT communications in which Process Data Objects

communications
(Communications
using Process Data
Objects)

(PDOs) are used to exchange information cyclically and in real time.
This is also called “process data communications”.

PDO Mapping The association of objects used for PDO communications.

PDO Entry PDO entries are the pointers to individual objects used for PDO
mapping.

ESI file An ESI file contains information unique to the EtherCAT slaves in XML

(EtherCAT Slave format.

Information file)

You can load ESlI files into the EC-Engineer, to easily allocate slave
process data and make other settings.

ENI file
(EtherCAT Network
Information file)

An ENI file contains the network configuration information related to
EtherCAT slaves.

Power PMAC IDE

This computer software is used to configure the Controller, create user
programs, and monitor the programs.
PMAC is an acronym for Programmable Multi-Axis Controller.

Acontis
EC-Engineer

This computer software is used to configure the EtherCAT network and
each slave.




3. Precautions

(1) Understand the specifications of devices that are used in the system. Allow some margin
for ratings and performance. Provide safety measures, such as for installing a safety
circuit, in order to ensure safety and minimize the risk of abnormal occurrences.

(2) To ensure system safety, always read and follow the information provided in all Safety
Precautions and Precautions for Safe Use in the manuals for each device that is used in
the system.

(3) The user is encouraged to confirm the standards and regulations that the system must
conform to.

(4) It is prohibited to copy, reproduce, or distribute a part or the whole of this document
without the permission of OMRON Corporation.

(5) The information contained in this document is current as of July 2016.

It is subject to change without prior notice for improvement purposes.

The following notations are used in this document.

Indicates a potentially hazardous situation which, if not avoided,
may result in minor or moderate injury, or may result in serious
injury or death. Additionally, there may be severe property
damage.

/A WARNING

T C t Indicates a potentially hazardous situation which, if not avoided,
aution may result in minor or moderate injury, or property damage.

IE' Precautions for Correct Use

Precautions on what to do and what not to do to ensure correct operation and performance.

@ Additional Information

Additional information to read as required.
This information is provided to increase understanding or make operations easier.

Symbols

The filled circle symbol indicates operations that you must carry out.

The specific operation is shown in the circle and explained in text.

This example indicates a “general precaution” for something that you must
carry out.




Overview

This document describes the procedures used to connect the OMRON Confocal Fiber Type
Displacement Sensor Controller Equipped with EtherCAT model ZW-CE1L] (hereafter
referred to as the Slave) using OMRON Programmable Multi-Axis Controller model
CK3E-UOOO/NY510-ALOO (hereafter referred to as the Controller) and EtherCAT, as well
as for checking the connection.

Refer to Section 6. EtherCAT Connection Procedure to learn about the setting methods and
key points to perform PDO communications via EtherCAT.



5. Applicable Devices and Device Configuration

I 5.1. Applicable Devices
The applicable devices are as follows:

Manufacturer Name Model
OMRON Programmable Multi-Axis Controller Model CK3E-DIDOL
OMRON Programmable Multi-Axis Controller Model NY510-ACICIC

Industrial Box PC
OMRON Confocal Fiber Type Displacement Sensor
] ) Model ZW-CE10]
Controller Equipped with EtherCAT

IE' Precautions for Correct Use

In this document, the devices with models and versions listed in Section 5.2 are used as
examples of applicable devices to describe the procedures to connect the devices and check
their connections.

You cannot use devices with versions lower than the versions listed in Section 5.2.

To use the devices mentioned above with models not listed in Section 5.2 or versions higher
than those listed in Section 5.2, check the differences in the specifications by referring to the
manuals before operating the devices.

@ Additional Information
This document describes the procedures to establish the network connections. It does not
provide information on operations, installations, wiring methods, device functionalities, or
device operations, which are not related to the connection procedures. For more information,
refer to the manuals or contact your OMRON representative.



I 5.2. Device Configuration
The hardware components to reproduce the connection procedures in this document are as

follows:

Model CK3E-I0
Windows computer Model ZW-CE1[]
Power PMAC IDE

Acontis EC-Engineer

7 =4

*  ~ Ethernet EtherCAT
communications communications

Manufacturer Name Model Version
OMRON Programmable Multi-Axis Model CK3E-OO0C] Ver2.2
Controller
Confocal Fiber Type
OMRON Displacement Sensor Model ZW-CE10] Ver. 1.1
Controller Equipped with
EtherCAT
OMRON Ethernet cable (with industrial | Model
Ethernet connector) XS5W-T421-[1IMI-K
- Windows computer -
DT Power PMAC IDE - Ver. 2.2
Acontis Acontis EC-Engineer - Ver. 2.4.3

IE' Precautions for Correct Use

Prepare the ESI file described in this section in advance. Contact your OMRON
representative for information on how to procure the ESI file.

IE' Precautions for Correct Use

Do not share the connection line of EtherCAT communications with other Ethernet networks.
Do not use devices for Ethernet such as a switching hub.

Use the Ethernet cable (double shielding with aluminum tape and braiding) of Category 5 or
higher, and use the shielded connector of Category 5 or higher.

Connect the cable shield to the connector hood at both ends of the cable.

@ Additional Information

This document describes model CK3E-LILILIL] as an example. The same procedures can
apply to model NY511-ACICIC.

©



6. EtherCAT Connection Procedure

This section describes the procedure for connecting the Controller with the Slave via EtherCAT.
The description assumes that the Controller and the Slave are set to factory default.

I 6.1. Workflow

Take the following steps to operate the PDO communications via EtherCAT after connecting

the Controller with the Slave via EtherCAT.

6.2 Preparation for the Controller Setup

v

6.2.1 Creation of a New Project

v

6.2.2 Initial Settings of the Controller

v

6.3 Installation of ESI Files

v

6.4 EtherCAT Communications Setup

\4

6.4.1 Communications Setup for the EtherCAT Master

v

6.4.2 Distributed Clock Setup

v

6.4.3 PDO Map Settings

v

6.4.4 Creation of an EtherCAT Network Configuration
File

v

6.5 Controller Settings

\4

6.5.1 EtherCAT Network Configuration Settings

\4

6.5.2 EtherCAT Communications Check

\4

6.5.3 EtherCAT Variables Settings

\4

6.5.4 Writing the User Program

v
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6.5.5 Project Data Transfer

Prepare the Controller settings.

Install the ESI file for the Slave into
Acontis EC-Engineer.

Set up EtherCAT communications.

Set up the Controller.



I 6.2. Preparation for the Controller Setup

Prepare the Controller settings.
Install Power PMAC IDE and Acontis EC-Engineer on the computer in advance.

6.2.1. Creation of a New Project

1 Connect the Controller with the
computer via Ethernet cable.

2 Turn on the power to the
Controller.
3 Start Power PMAC IDE.

* |f the dialog for confirming
access rights appears upon
start-up, select starting of
Power PMAC IDE.

4 The Communication screen
appears. Specify the IP
address of the destination

Communication

oz 4|3

Controller and click Connect.

IPAddrezs 192.168.0.200 [=]
Port 22
*
The IP address of the Protocnl SSH
Controller is set to User root
. ., Pazzward S99 99
192.168.0.200" by default. ApplydllCantrols True
* |f necessary, Change the SelectDevice AtStartup True
Windows IP address to
“192.168.0.X". IPAddress
Set [P Address

Connect

[ Lazt Ses=zion I [ Mo Device I

For detailed setup options go to Tools menu -> Options
-> PowerPMAC

11



5 Power PMAC IDE starts, and is
online to the Controller.

.-‘_ Pawer PMAC Suite (TT9E)

Iﬂhm!mmmmnwmnu Window  Lalp
|l i e L a9 b Debug  x AnyCPU
- - tus [ 2og Rikbon | 4 Communication Setup _

-ty

e |
[ YUz =53 PowerPmac (1 TOST.
L] rovierPmac(io Device:)|
23 € Language

Ca Configuration

[ Docurnentation

3 Log
- [ PMAC Script Language

E-&-8 88

Faits7 AR

~a

2
HAROERG): Bk = | |t |

% powerPmac(No Device:) Froject Froper ~

| —
"1 User Buffer 1 -

18 PowerPMAC Communication Setup

D5z 71 PowerPmac OHFRICHALE LR,

6 From the File menu, select
New then Project.

=

% Power PMAC Suite (Administrator)

Edit View Tools Delta Tau

Window Help

New » | 5] Project...
Open L

Close

File...

Project From Existing Code...

Close Selution

Ctrl+5

Sawve Selected Items

I Save Selected Items As...
Save All Ctrl+Shift+5

Export Template...

0 | Page Setup...

|l & | Print... Ctrl+P

H Recent Files »

I Recent Projects b

Exit

Ctrl+Shift+MN U

CErl+N tup _

L)

7 Enter a project name and
location, and select OK.

Eropect s

IS
nBE

PreverPrec
s Prigect Tyees

[Fomees FraLl

ey [Eracrszan
Lmton

oudion hiage:

| CThcrsea0
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6.2.2. Initial Settings of the Controller
Configure the initial settings for the Controller.

IE' Precautions for Correct Use

Configuring the initial settings clears all data in the Controller memory. Back up necessary

data in advance.

In the Terminal pane, type the
$$$*** command to reset the
Controller to factory default.

| "~ Power PMAC Suite (/

File Edit View Project Build Debug Tools Delta Tau Window Help

E === I - - - b Debug -
Watch: Online[192.168.0.200:55H] ~ 0 X || Position: Onli

- | B

On
Send Demand Command Response

ST omsaoom ssises
[ |ECATID]Enable 1
[ Slave_0_6071_0_Targettorque |stdin:3:2: err... |

Terminal: Online[192.168.0.200:55H] -~ 1 x pp_disable.
FA A 3
LD
disab
clear

enabl

|55511\1\| 4

2 From the Tools menu, select
System Setup to start System
Setup.

PowerPMAC System Setup
starts.

S Prowper PMAL Suite (Admunistrator)

Fle Edt Viw Debug [Toos | DeaTau ‘Windew Heb

Je 050 OEEETEENE

B Termna g Pastion [T W Ao

B s

On | B TeskManager
Send B d El:rnrni A
1 11 Lne
r ECATIO|
& Abtach to Frocsms..,  Ciri+alt+?

O ErAT)n| | Attach to Froce s
M [ecamm| POt p——

Exhernal Tools.

Do, ..,

13



3 From the File menu of
PowerPMAC System Setup,
select New then Setup.

PowerPMAC System Setup @ Online[192.168.0.200:55H]

File | Database

| New v Setup I
Add 3
Save Setup
Restore Setup

4 Specify Servo Frequency.

Select the Servo Frequency
setting from 4 KHz, 2 KHz, or
1 KHz.

* Servo Frequency is set to 1 kHz
for the example in this document.

Global Clock Setting

Phage Frequency 1.000 kHz

Servo Frequency (1000 =l kHz

Detected Servo Hardware-PWM Frequency

5 Click the Accept button.

e 50, [

Q

i &l
Mew clock  PowerPMAC w’t |

Eams settings  Value

Servo Period (msec) 1000 1.000
FhaseCherServoPeriod 1000 1000

Ho Master Gate detecied and Mo

ETHERCAT option detected

PowerPMAC can be used asa PCusing | _
‘ software clock. (sys CPUTimerdntr = 1) On|

Accepting the clock issus save and 555

in the terminal window for changes to

take effect Check 'sys. SenvoTime’ to

6 If you have changed the servo
frequency setting, type the SAVE
command in the Terminal pane of
Power PMAC IDE.

When complete, the “Save
Complete” message appears in
the Terminal pane.

Terminal: Online[192.168.0.200:55H] ~ 0 X

14



7 Click Communication Setup on

[ Power PMAC St

the toolbar to display the Device | ac wi ven oo Took Dotaon viniow o
) A B- - Ha N T | B}
Propertles dlalog bOX. W Termnal B posuon B warch B Stanes i jog rilon i Wnn—a‘mu-,q:n:smw'_ j
Watch: Dffine - 0 X . jia-—sa>TFa0-5 -0 X
S — & Device Properties _ Qﬁ-.id1L
| Lea) oo

ENEOBES):

8 In the Device Properties dialog
. B Device Properties . [
box, select No Device for IP l‘ T l
. Test Apply
Address, then click the Apply &
Easl
button. il -
IPAddress ‘_‘
PortHumber =
. . Protocol S55H —
This operation sets the Controller oo oot _ v
IPAddress
to the offline state. Set P Address

9 The Controller restarts.

The servo frequency that has
been set is reflected.

10 Wait until the startup process of

the Controller is complete. Then (8 peve eroveees S L)
click Communication Setup on )] | st
the toolbar to display the Device .
Properties dialog box. == — E'D
User root -

In the Device Properties dialog

IPAddress‘
box, return the IP Address to the Set IP Address

previous setting, then click the
Apply button. -

This operation sets the Controller
to the online state.

15



I 6.3. Installation of ESI Files
Install the ESI file for the Slave into Acontis EC-Engineer.

M Precautions for Correct Use

Prepare the ESI file described in this section in advance. Contact your OMRON
representative for information on how to procure the ESI file.

1 Start EC-Engineer. \
£ Power PMAC IDE 4

&

-_-_| Windows Explorer 4

8|

#’ EC-Engineer »
[ Paint ¥

All Programs

|Search programs and files Fe |

16



2 From the File menu of EC-Engineer,

select ESI Manager. View Network Settings Help
% New Ctri+N
The ESI Manager appears. i Open EiD I
H save Cirl+S
K saveas
Print
ap Add Master-Unit 3

ESI Manager

EMI Manager

= Recent Projects 3

Exit Alt+F4

Example of the ESI Manager

(= st Manager §—— STy
ESI Files
Sefect an ESI file which should be delated or exported or sdd new ESI files,

£ Baumueter Nusmberg Gt

B Becknoff Automation GmbH & Ca, KG
€ Capley Controls Carp

L lenae

B OMRON Corporation

wre VIPA GMbk

v v T T ¥

¥ yasiawa Dctric Corporation

Number of ESI files: 79
Number of devices: 1930 .

Add Flle Add Folder Cloge

3 Cor.lflrm th?t Omron ZYV-C.:Elx.me is T — I
registered in the ESI file list of ESI [ st e

Select an E51 file which should be deleted or exported or add new E5I files. |

Manager' b G Copley Controls Corp. o
L3 o |E -
b Cimnon GX-Digital 10 sxmi ?l
If it is not yet registered, click Add ! e e
. . Add File Add Folder Close
Fileandregister Omron 2ZW-CE1x.xml. |
([ Add ESI File N
@@i .. « Documents » SystemEsiFiles w | ¥4 [l Search SystemEsiFiles »
Organize New folder =~ 0 @
r Favorites ~  Documents library - .
P Deskiop SystemFsiFiles led
18 Downloads e = A
%] Recent Places =) e

2] Omron GX-JC06-H

i Libraries =] Omron MX_Coupler
@ Documents 2] Omron NX_Modules
@ Music || Omron R88D-KMioo-ECT
[&5] Pictures 2] Omron RE8D-KMoo-ECT-L ]
B8 videos || Omron ZW-7
|2 Omron ZW-CElx I e
M Comnuter 52 m | S

File name: Omron ZW-CElx + |ESIFiles (*xml) -

=)




4 Click Close to close the ESI
Manager page.

I 6.4. EtherCAT Communications Setup
Set up EtherCAT communications.

M Precautions for Correct Use

Before taking the following steps, make sure that the devices are connected via an Ethernet
cable. If they are not connected, turn OFF the power to the devices, and connect the Ethernet

cable.

6.4.1. Communications Setup for the EtherCAT Master

1 Connect the Controller with
slave devices using an Ethernet
cable.

* Refer to the manuals for slave
devices to configure them.

2 Display Start Page of
EC-Engineer, and select

IR Diagricsis Mode

EtherCAT Master Unit (Class e
e
A) from Add Master Unit. TR

EC = Engineer

Getting Started

|| Classic view | Flat View | Topology View

3 Class-A Master is added to the
Project Explorer.

Source MAC acdress

18



4 In the Master page, specify a
communication period for Cycle
Time [us].

* You must specify the
communication period in
accordance with the servo
frequency of the Controller.
1000 us is set in this document.

Master

General
nit Kama

Cycle Time [us] 1000

-

Slaves connected to local system
Mty Aciapter O~ TUPHE | Intel(R) Ethenet Connection [217-LM )

Salact
Slaves conmected to remote system
1P Acdciness 192.168. 0 . 200
Part 000
Master-Instance o Saelact

Correspondence between the servo frequencies of the
Controller and communication periods is as follows:

4 kHz : 250 us

2 kHz : 500 us

1 kHz : 1000 us

5 In the Master page, enter the IP
address of the Controller in IP
Address, and click the Select
button to apply the setting.

* Default IP address
“192.168.0.200" is specified in
this example.

* Do not select Slaves

connected to local system as it

is not used.

Device Editor
Master

General
Unit Nama Clags-A Magter
Cyce Time [us] 1000

Source MAC address

Slaves connected to local system
Mebwari-Acaptes D77 TUPRE ( Intel(R) Ethernet Connection L117-LM )

1P Acdciness 192.168. 0 . 200
: — I
€000

Master-Instance o

6 Right-click on Class-A Master in
the Project Explorer, and select
Scan EtherCAT Network from
the menu.

= EC-Engineer [--]

File  View Network

£ Configuration Mode ™|

Settings Help

B Diagnosis Mode

Project Explorer Device Editor
. Class-A Master Master

*.. Scan EtherCAT Network

dF Append Slave General
Unit Name
® Remove Master-Unit Cycle Time
Source MAC
Slaves conne
& Import Slaves from ENI File N

# Change Master Unit

Make sure that the slave is
displayed in the Project Explorer.

= EC-Engineer [--]

File View Network Settings Help

{ Configuration Mode IS I Glyd=1 B Diagnosis Mode

Project Explorer
- . Class-A Master
@ Slave_1001 [ZW-CE10T] (1001)

19
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6.4.2. Distributed Clock Setup

1 Setting Distributed Clocks (DC)
for Master

EELT e —
File View Network Settings Help
< Configuration Mode [l 12 i
-

e
_— lmoess Data Image | Vaniables | Advanced Options | Slave to Sla . ulty
In the Project Explorer, select - P T
Class-A Master to display the @ i sun
Distributed Clocks tab page.

@ Master Shift (EtherCAT Master Time controlled by Reference Clock)

Bus Shift [Reference Clock controlled by EtherCAT Master Time)
Options

Continuous Prapagation Compensation
] Sync Window Monitaring

Show 648it System Time

* |f the Distributed Clocks tab does not appear, select View
then the Expert Mode check box.

= EC-Engineer [--]

File Network  Setting

vy Messages
Y

Short Info
Projes

- Expert Mode

Refresh

F5
2 Select Master Shift (EtherCAT

Master Time controlled by

[=]EC-Engineer ]
File
Reference Clock).

View  MNetwork  Settings  Help
£ Configuration Mode = 12 a i

B Disgnosis Mode

a S\IMTJOM [ZW-CE10T] (1001)

Reference Clock

| . Class-A Master Mastes | Process b-m:énage- Varisbles Mﬁn::dapl-\cms Slave to Slave | Drstributed Clocks “t;lh;lw
Name

Stave_1001 [ZW-CELOT] (1001)

® Master Shift (EtherCAT Master Time controlled by Reference Clock)

Uz SIIT [Reference Clock contraied by ETherCAT Master Time)
Options

Continuous Propagation Compensation
] Sync Window Monitaring

Show 648it System Time




3 Setting Distributed Clock (DC)

for the Slave

In the Project Explorer, select
the target slave to display the
Distributed Clocks tab page.

file  View Network  Settings  Help
e
o T
s e General | PDO Mapping | Varables | Advanced Opitics i
I l—'“'_—' _“—"'l Distributed Clock
Cperation Mode DC Syncd
Syme Unit Cyele {us) 1000
Crverwite Mode Fl
4 Syne Units
o Syme Unit 0
Cyche Time
& Syns Unit Cycle k1 1000 s
User defined 1000
Shift Time (us) 500

Select the Overwrite Mode
check box and specify Shift
Time.

file  View MNetwork Settings  Help

Mot B Ouot
* | Class-A Master . General | PDO Mapping | Variables | Advanced Options | Distributed Clock |fni
@ Stave 1001
C A Iw-cetom ooty | b c
Operation hode DL Syncl)
” ye———
I Crverwite Mode Fl I
I Syne Units
o] Syme Unit 0
Cycle Time
& Syne Unit Cycle %1 1000 us

I Shift Tirne {us) |:;I?;I-I
Correspondence between the servo frequencies of
the Controller and Shift Time values is as follows:
4 kHz : 125 us

2 kHz : 250 us

1 kHz : 500 us

21



6.4.3. PDO Map Settings

1 In the Project Explorer, select

the target slave to display the
PDO Mapping tab page.

= EC-Enginger [--]
‘;.‘a View MNetwork Seltings  Help

BT we e

B Biagnusis Made

2 Check the Inputs field to make

sure that only the 260th
transmit PDO Mapping
0x1B03 check box is selected.

* |f you want to use other data,
clear the currently displayed
check boxes and select other
desired check boxes.

Check the Outputs field to make
sure that only the 260th receive
PDO Mapping 0x1703 check
box is selected.

* |f you want to use other data,
clear the currently displayed
check boxes and select other
desired check boxes.

- Genent ariables | Advanced Options | Distributed Clock | Init Commands | CoE Objec
@ Slove_1001 [ZW-CE10T] {1001
Inputs
A 257tn transmiz FDO Mapping (exciuded by 0xiB03) [
E
- 258th transmit PDO Magping (exciuded by 0x1B04) Ox1801
- 259th tronsmit PO Mapping {oxciuded by 0x1805) 01802
¥ ¥ 260th transmit PDO Mapping 0x1803
LG B 5A010:02
SYNCFLG Bit 03010:03
Inputs
v 257th transmit FOO Mapping (exciuded by Ox1803) [53 1= T
Kame Index BNt LLengrtn
Fiag E
- 258th transmit FOO Mapping {exciuded by 0x1804) Ox1B01
Name diex B
Sen exd L
- 259th transmit FOO Mapping (excluded by Tx1805) QclB02
Harns Ind Bit Lang
v [ 260m transmit PDO Mapping 01803
YO T TR
FLG Bit Ca3010:02
SYNCFLG B O30 o3
Outputs
- 257th receive POO Mapping (excluded by Gx1703) Bxi?O0 _*
Name Langs
Fag A
- 255th receive PDO Mapging (exchuded by (1704} 01700
daeT Endex B Lengtt
ancor Headl Cantrol Flsg 3
v 255th receive POO Mapping (exciuded by Ox1705) G102
Mama iy Bl Length
* || 260th receive PDO Mapping Ox1703
NI J{g 2 it LengRn
EXE Bk O 300002 1
SYNC B8 Om2000:03 1

22




6.4.4. Creation of an EtherCAT Network Configuration File

Click Export ENI on the upper
1
part of the EC-Engineer page.

= EC-Engineer [--]

File View MNetwork Settings Help

“{ Configuration Mode

= Export ENI

B8 Diagnosis Mode

2 Enter a file name, and then click
Save to create an EtherCAT

=+ Export EtherCAT-Metwork-Information (ENI) File
_—

mv| .+ Computer ¢ Local Disk (C) » tmp

network configuration file. e = @
& Local Disk (C:) = Mame ° Date modified Type
. DeltaTau
| inetpub Mo items match your search.
. Intel
. OE-Downloade—,
. Omren L
.| Perflogs i
.. Program Files
. Program Files
A tmp v 4 T r
I File name: m i -
Save as type: lEtherCAT-Network-Information (EMI) Files (*xml) ']
= Hide Folders Sove | Cancel |
I 6.5. Controller Settings
6.5.1. EtherCAT Network Configuration Settings
1 From the TOOlS menu Of Power PowerPMAL System Setup © Ondned 192.168.0,200:58H] \M
PMAC IDE, select System e ior R
. T Hardmarn Dispresss: ——
Setup to display System [ 1o EtherCAT.
EXherCAT Licanse Status: EtherCAT 10 Devices Liconse Only
Setu p ) EtherCAT Master ype: ACONTIS
Browee io eni file [Browse] [ Downicad ENitie |
PowerPMAC System Setup ; Ondned 192, 168.0,200:58H] T B i

2 Click Browse, and load the
EtherCAT network configuration
file created in 6.4.4 Creation of
an EtherCAT Network
Configuration File.

| File Database

HE Bt o,
o o EtherCAT. ™
b o aster (0] Duactatend]

ETherCAT Licanse Status: EtherCAT 10 Devices Liconss Only
EtherCAT Master hype: ACONTIS

Browse to eni file

Downioad ENltle. |

3 Click Download ENI file to
download the EtherCAT
network configuration to the
Controller.

—
EtherCAT. ™

EtherCAT License Status: EtherCAT IO Devices Licensa Only
EtherCAT Master type: ACONTIS

Browse to eni file
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6.5.2. EtherCAT Communications Check

Take the following steps to ensure that EtherCAT communications are available.

1 From the Terminal pane, run the
ECAT[0].Enable=1 command to
start EtherCAT communications.

Terminal: Online[192.168.0.200:55H]

ECAT[0].Enable=1

2 In the Terminal or Watch pane, Watch: Online[192.168.0.200:55H] - I x
make sure that the Send g;mand Command Rezponze
ECAT[0].Enable value turns to 1. R J i ao

ECAT[O].Enable 1
* The OP mode is entered and ECATIO]. Error 50
EtherCAT communications are L
established.

3 After making sure that correct Watch: Online[192.168.0.200:55H] S
communications are available, run Send g;mand Command Thee
the ECAT[0].Enable=0 command ey i
from the Terminal pane to stop ECATI0].Enable 1
EtherCAT communications. ECATIO] Error 50

L]

| Terminal: Online[192.168.0.200:55H]

erminal
munication

owerPMAC at 192

ECAT[0].Enable=0

4 In the Terminal or Watch pane,
make sure that the
ECAT[0].Enable value turns to O.

Watch: Online[192 168.0.200:55H] » 01 X
Send B Command Responze
Demand
Sye SenaConnt 1852214
ECAT[0].Enable o
ECATIO].Error 50
L]
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6.5.3. EtherCAT Variables Settings

1 In the System Setup page,

right-click on
Master[0].Deactivated to
display the pop-up menu, and
select Export EtherCAT
Variables.

PowerPMAC System Setup : Online[192.168.0.200:55H]

File  Database

5 Power PMAS {192.168.0.200

_

EtherCAT. ™
L

rt EtherCAT Variables —————

TITET G CICETTS e TS l_tI'IErCAT 10 Device

EtherCAT Master type: ACONTIS

Enter a name for the EtherCAT
variable definition file for user
programs into the root of the
project folder.

-
 Save As

@'O”-" <« My Documents » o s 5 e « 4+ I se
= - ———

Organize v New folder
A Favorites 4 Name Date modified Type Size
B Desktop Bin 7/8/2016 8:42 PM  File folder
&8 Downloads C Language 7/8/20168:42 PM  File folder
%] Recent Places Configuration 7/8/20168:42PM  Filefolder
Documentation 7/8/2016 842 PM  File folder
i Libraries L Log 7/8/2016 842 PM  File folder
) Documents PMAC Script Language 7/8/2016 842 PM  File folder
& Music
& Pictures
BB videos
1% Computer P
& Local Disk (C)
File name: ECAT Variables &
Save as type: | ppmac header files (*.prmh) v]

The created EtherCAT variable
definition file is added to under
Global Includes of PMAC
Script Language in Solution
Explorer.

Velocity: Onling[192.... v & X | | Following Error: Onli

~ 1 x| Selution Explorer - Solution".. ~ & X

nu |

[ Solution 'PowerPmac?’ (L project)
- ] PowerPmac2(192.168.0.200:x¢
£3 C Language
[ Configuration
[ Documentation
[ log
) [ PMAC Script Language
£l [ Global Includes

[Eil =cat varisbles.pmh)

[ Kinematic Routines

b BB

 ecat varizbles) ecat_variablespmh

#define Slave_0_3220_1_OutputBit00 ECAT[0].IO[0].Data
#define Slave 0 _3220_2 CucputBit0l ECAT[0].IO[1].Data
#define Slave 0 _3220_3_CucputBit02 ECAT[0].IO[2].Data
#define Slave_0_3220_4_OutputBit03 ECAT[0].IO[3].Data
#define ECAT[0] .IO[4] .Data
#define - 6 ECAT[0] .IO[5].Data
#define Slave 0_3220_7_OutpurBit06 ECAT[0].IO[6].Data «

|

[24 Metien Programs
[ PLC Programs

[ v
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6.5.4. Writing the User Program

Create programs to be used to check operations.

A specific language is used for the operation check programs. Refer to Power PMAC User’s

Manual and Power PMAC Software Reference Manual for details.

1 nthe Solution Explorer pane, - N -~
open Project name — PMAC
X P -Tun-.m,l
Script Language — PLC e e ey
Programs —plcl.plc. prqseme e
A pp_cdsablers
] pp_imc_disable.tat
8] pp_inc_startup.bi
B srecly
myecatlp” ecatsctivatel.oly | 21510086 | 20151028 pmh s x n—i‘f_ﬂ:’:‘::
‘; < Leg
L PRaAC Seript Langusge
2 Globad Inchades
MASI0H prby
hekul defintiont prh
i Kinematic Routines
.  Lbwanes
v [ Meotion Programa
" ||| ecatscthatelloly Fie Properties
ol
2 In the programming area of the open plc 1

plcl.plc tab page, write a '
program as shown on the right. while(sys.ecatMasterReady==0){}

ECAT[O].Enable = 1;

This sample program repeats P1000 = Sys.Time + 1;
the process of sending the while(P1000 > Sys.Time){};

command after one second, Slave_0_3003_0_Command = $00404000;
turning OFF the transmission bit Slave_0_3004_1 CommandParameterl = 900;

after one second, sending the Slave_0_3000_2_EXEBit = 1;
command after one second,
then turning OFF the P1000 = Sys.Time + 1;

o ) while(P1000 > Sys.Time){};
transmission bit after one

second. Slave_0_3000_2_EXEBit = 0;
P1000 = Sys.Time + 1;
* In this example, PDO mapping while(P1000 > Sys.Time){};
is assumed to be the default Slave_0_3003_0_Command = $00404000;
setting. If you want to change Slave_0_3004_1_CommandParameterl = 901,

i i Sl 0 3000 2 EXEBit=1;
PDO mapping, rewrite the ave_0_3000 2_ i

“Slave_0...."” description. P1000 = Sys.Time + 1;
while(P1000 > Sys.Time){};

Slave_0_3000_2 EXEBit = 0;

close
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3 Setting the start of the user

program ndow  Help

thug = Any CPU
In the Solution Explorer pane,
open Project name —

Configuration — i £ Reaitime Routines

Configusation
. p.diableixt | myscatchgl scatactnmted.cfy | 200500080 ¥ X = L“'.'. *_ " S5
pp_disable.txt. e e et e e o] scatactivatad.cfg
- T A T e ] st oly

B PR custom wave.dg
disable plc

clear sll buffers

ppsavecy
5] pp_steriup
& [ Documentation

i leg

pp disable twt Fle Propeties
B

4 In the programming area of the
pp_disable.txt tab page, add the enable plc 1;

program shown on the right to
the last line.

The pp_disable.txt program is
automatically executed when
the Controller starts.

This example program runs the
PLC1 script.

6.5.5. Project Data Transfer
Transfer the created project data to the Controller.

/A WARNING

When the user program and “configuration and setting” data are transferred from
Power PMAC IDE, devices or the machine may perform unexpected operations.
Therefore, before you transfer project data, ensure the destination slave is

operating safely.

Transferring project data restarts the Controller and interrupts communications

with slaves. The time that communications are interrupted depends on the
EtherCAT network configuration.

Before you transfer project data, make sure that the slave settings will not
adversely affect the devices.
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1 In the Terminal or Watch pane,
make sure that the
ECAT[0].Enable value is 0.

If the value is 1, run the
ECAT[0].Enable=0 command
from the Terminal pane to stop
EtherCAT communications.

- Power PMAC Suite (Administrator)

File Edit View Project Build Debug Tools DeltaTau V

S R = - B TN Y RO I ]
b oax|EE|IE 2O & B

@ Terminal 4 Position [Z] Watch |8 Status @ Jog Ribbon | < ¢

Watch: Online(192.168.0.200:55H] ~ 1 x
Send g;mand Command Response
1 | |ECATIOlEnable 0

#1- Make sure that ECAT[0].Enable=0

Terminal Online[192.168.0.200:55H]

2 Downloading a project

Right-click the project name in
the Solution Explorer pane on
the upper right of the IDE
screen, and select Build and
Download All Programs to run
the build and download.

Solution Explorer - Powe... » I X

=)
(oA Solution 'PowerPmac_ECC201+8
=

— .__.r C Language ¥ | Build

+-- [ Background F

% 3 CPLCS

+ 3 Include

Clean

Debug

----- 3 Libraries

Build and Download All Programs

. - 1 Realtime Rol
+ [J Configuration
= 3 Documentation
5 3 Log

#- [ PMAC Script Lan ¥ | cut

Download All Programs
Map PMAC Variables
Add Macro Project

X | Remove
Unload Project

1 L[] Properties

=
Properties > I'X ] r

3 Make sure that there are no
errors in the Output tab page.

* |f the transfer fails, check
details of the error in the Output
tab page.

If the error is a program error,
you must review the program.

If the error is related to
EtherCAT settings, return to
System Setup and check
whether there are any incorrect
settings.
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4 The program starts running

when it has been downloaded
successfully.

EtherCAT communications are
in the OP state. Make sure that
the command is sent.

* If the command is not sent,
check that the ECAT[0].Enable
value is 1 in the Terminal or
Watch pane.

If the value is O, run the
following command from the
Terminal pane.

enable plc 1

Terminal: Online[192.168.0.200:S5H] >~ 01 X

|enable plc1

After you have confirmed an
appropriate operation, save the
project to the Controller.

Run the save command from
the Terminal pane.

* The transferred project is not
yet saved to the Controller at
this stage.

If you turn OFF the power to the
Controller, the transferred
project will be discarded.

Terminal: Online[192.168.0.200:55H] ~ 01 X

Save Complete
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The following describes the procedures to save a Power PMAC IDE project on the computer, and to

7. Appendix Saving and Loading a Project

reuse it.

I 7.1. Saving a Project

1 Creating a Configuration File

Create a Configuration File to save

parameters you have changed in System
Setup to the project.

Right-click Configuration in the Solution
Explorer pane, and select Generate
Configuration File.

A Configuration File is added to
Configuration.

- DI:IJ:IFDj.h
----- [ Libraries
[~ [ Realtime Routines
[=SlE ) Configuratios

----- | 7| ecatad Add
----- pP_cuy ¢ :
= i==) | Properties
..... || Pp_cug = P
- |E] pp_dis Upload Config Files

Daownload Config Files

..... Generate Configuration File

[ [ Documentation

L B 11 Am

2 Right-click on the Configuration File, and
from the menu, select Check To Download
Config File to include it in files to be
downloaded.

|:||I Iﬁ',lﬂ',f [: [.

3 [

<
Prope

oriain

& Configuration

m

Open With...
[Z] | View Code
Exclude From Project
>( Delete
Rename
Check To Download Config File

i | Properties

3 Saving a Project 4 Power PMAC Suite

In the File menu, run Save All to save the
project on the computer.

Edit  View

New
Open
Add

Close Selution
Upload Projec!
Save uPowerP
Save uPowerP

Save All
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I 7.2. Loading and Downloading a Project

Start Power PMAC IDE, and
connect to the Controller.

In the Terminal pane, type the
$$$*** command to reset the
Controller settings to factory
default.

>~ 0 X

Terminal: Online[192.168.0.200:55H]

In the File menu, Click Open —

<+ Power PMAC Suite (Administrator)

Projectlsolution tO |Oad the Edit View Tools Delta Tau Window Help
act New pho-d- [pebug ~|[any cou || %
prOJeC ' » | 51 Project/Solution... Ctrl+Shift+0 .
= | File... Ctrl+0 0:... I X || Velocity:
Response 0 = ?
ST o o 3
i Items As y 4
Ctrl+Shift+5 _ #5
te f -
F"l-*: +P
Recent Files 4
Recent Projects 3
Exit
4 From the Tools menu Of Power PowerPMAC System Setup : Ondne{192.168.0,200:55M] o | i
File Database
PMAC IDE, select System Setup —
] EtherCAT. ™
to display System Setup. e
Browse to eni fils Browse Duwnivad ENI te
5 Click Browse, and load the ENI pr—
EtherCAT.

configuration file that you created
in 6.4.4 Creation of an EtherCAT
Network Configuration File.

EtherCAT License Status: EtherCAT IO Devices License Only
EtherCAT Master type: ACONTIS

Browse to eni file

| Download ENI file |

Click Download ENI file to
download the EtherCAT network
configuration to the Controller.

——
EtherCAT.

EtherCAT License Status: EtherCAT IO Devices License Only
EtherCAT Master type: ACONTIS

Browse to eni file

B‘m
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7 Right-click Configuration in the

Solution Explorer pane, and
select Download Config Files to
download the file to the Controller.

=

- = Include
i | ] 20160204.h

[ pp_proj.h
----- 1 Libraries

Bf=1 Configuration
----- || ecatactiva
|| myecat.cf
----- ] pp_custon
----- | pp_custon

Solution Explorer - Solut... » 10 X

+-- [ Realtime Routines

-

Add »
Properties

Upload Config Files

- |2 pp_disablg

Download Config Files

- |2 pp_inc_dis
- |2 pp_inc_stz.

Generate Configuraticn File

----- | pp_save.cfg
- 2] pp_startup.ixt

=

]

8 Right-click the project name in the
Solution Explorer pane, and =

Solution Explorer - Powe... w I X

_: Solution 'PowerPmac_ECC201+5

select Build and Download All
Programs to run the build and
download.

When the download process is
complete, make sure that there
are no errors in the Output tab

[ C Language
- 3 Background B
- [ CPLCs
- 3 Include

=Mm| FowerPmac_ECC201+Safe

Build
Clean

Debug

- [ Libraries

% [ Configuration
+- £ Documentation
Bl | Log

4 Realtime Rot———f e A Prograrms

Build and Download All Programs

Map PMAC Variables
Add Macro Project

- [ PMAC Script Lan| ¥ | cut
page.
¥ | Remove
Unlead Project

1 m i | Properties

Properties - I X l r
Stopping a program Terminal: Online[192.168.0.200:55H] ~ 1 X
If a program is running, execute I
the following command from the

i |disable ple 1

Terminal pane to stop the
program.
disable plc 1 Terminal: Online[192.168.0.200:55H] .

ECAT[0].Enable=0

“ECAT[D].EnabIe=D
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10

Saving the downloaded settings
and programs

After the download process is
complete and you make sure that
there are no errors in the Output
tab page, run the save command
from the Terminal pane.

* The save command stores the
downloaded project in the
Controller. This operation saves
the settings to be executed
automatically when the power to
the Controller is turned on.

Terminal: Online[192.168.0.200:55H]

Save Complete

}SEVE

11

Restarting after download

Run the following command from
the Terminal pane to restart the
Controller with the downloaded
project.

$$3$

Terminal: Online[192.168.0.200:55H]

usss
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8. Appendix Troubleshooting

8.1. Factors Causing EtherCAT Communications To Be Unavailable, and
Corrective Actions
Description Factor Corrective Action

The link is not established.

The Ethernet cable is broken or
the specified cable is not being
used.

If the Ethernet cable is broken
or if the specified cable was not
used, replace the cable.

A connector on the Ethernet
cable used for EtherCAT
communications is
disconnected, the contact is
faulty, or parts are faulty.

Reconnect the connector and
make sure it is mated correctly.

A slave within the EtherCAT
network configuration failed.

Replace the slave.

EtherCAT communications do
not start.

ECAT[0].Enable is set to 0.

From the Terminal pane, run the
ECAT[0].Enable=1 command to
start EtherCAT communications.

The EtherCAT network
configuration in the Controller
does not agree with the
physical network configuration.

Review the settings according
to the procedures provided in
6.4 EtherCAT Communications
Setup.

The Ethernet cable is broken at
a slave in the network, or a
connector is disconnected.

Connect the Ethernet cable
correctly.

Some errors have occurred,
and the ECATJO].error is setto a
value other than 0.

Check the ECAT]O].error value.

A synchronization error occurs
at a slave.

The distribution clock is not set
correctly.

A slave in Free-Run Mode is set
to the reference clock.

Review the settings according
to the procedures provided in
6.4.2 Distributed Clock Setup.

The servo task processing time
exceeds the set period.

Review the program or servo
frequency to adjust it, so that
the servo task processing time
does not exceed the period.
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I 8.2. How to Check for Errors

8.2.1. Checking the EtherCAT Status
You can check the EtherCAT status from System Setup of Power PMAC IDE and Diagnosis Mode
of Acontis EC-Engineer.

B System Setup of Power PMAC IDE
You can check the status of the EtherCAT master and slaves in the System Setup page of Power

File  Database

549 PowerPMAC (192.168.0.200)
¢ s Hardware Diagnosis
4 Motors

YY) ctcr{0] Activated

—
EtherCAT.

EtherCAT License Status: Mo License

EtherCAT Master type: ACONTIS

C\U=sers\OMRON_IPC_1\Desktopleni.xm!

[Browse| [ Download ENIfile
STave status
ECAT[®].5laveCount=2 B Mo Status Emor  Description
ECAT[@].TxTime=3
ECAT[®].RxTime=1 0 o] Mo Slave_1001 [GX0D1611]
BERE L= D e 1 oP No | Slave_1002 [GX-MD3218]

B Diagnosis Mode of Acontis EC-Engineer
You can check the status of the slaves in the Diagnosis Mode page of Acontis EC-Engineer.

i B EC-Engineer [__]- _\E@lﬂﬂ

|| File

View

Network

#. Configuration Made

Project Explorer

Settings

m

- @ Class-A Master <connacted>

Help

[ Diagnosis Mode

Device Editor
General |'\-"ar|'ables || ESC Register ” EEPROM || Extended Diagnosis " DC Diagnosis ” CoE Q[4][]

| o Slave 1001 [GX-0D1611] (1001) |
@ Slave 1002 [GX-MD3218] (1002}

State Machine

Current State |0p
Requested State |0p
Init
Change State Pre-Op Safe-Op
Error State
Current No error
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Select Network then Network Mismatch Analyzer from the menu to verify the network configuration.

= Network Mismatch Analyzer @Elﬂ

List of slaves

Please, compare the configured slaves with the connected slaves. If something is red, you have a
netwaork configuration mismatch!

Name Configured Slave Revision Alias | Network Slave Revision Alias

Slave_002 [R88 | R88D-KNO1L-ECT [2] 0x00020001 O REBD-KNO1L-ECT [2] | 0x00020001 | 1

Slave_003 [RE8 | RB3D-KNO1L-ECT [3] | 0x00020001 | O

Close

8.2.2. Checking the Controller Status
In the Status page of Power PMAC IDE, you can check the status of the motor, coordinate system,
and system.
To display the Status page, click Status on the toolbar.

B Global Status
You can check system errors such as the WDT error.

Status: Online[192.168.0.
Motor Status] Coordinate Status MACRO Status ] ECAT Status ]
Glebal Status
Description Status Description Status
Abortall False HWChangeErr False
BufSizeErr False MoClocks False
ConfigloadErr False ProjectLoadErr False
Default False PwrOnFault False
FileConfigErr False WD TFault MoFault
Flash5izeErr False
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Bl Motor Status
You can check deviation errors, limit errors, and other states of the motor.

Coordinate Status] Global Statusl MACRO Status l ECAT Status ]
Motor 0 = ® Motor not activated

| Description Status Description Status
_ False IZtFauIt. i:alse
AmpFault False InPos False
AmpWarn False LimitStop False
AuxFault False MinusLimit False
BIDir Plus PhaseFound False
BlockRequest False PlusLimit False
ClosedLoop False SoftLimit False
Csolve False SoftLimitDir Plus
DacLimit False SoftMinusLimit False
DesVelZero False SoftPlusLimit False
Encloss False SpindleMotor False
FeFatal False TraceCount 0

| FeWarn False TriggerMove False

| GantryHomed False TriggerMotFound False
HomeComplete False TriggerSpeedsel MaxSpeed
HomelnProgress False

B Coordinate Status

You can check deviation errors, limit errors and other states of the coordinate system.

Status: Onling[192.

SSH]

Motor Statu CDDn:ImateStatu] Global Status] MACRO Status l ECAT Status ]
Coordinate System 0 =
Description Status Description Status it
|AddedDwelbis IS LinToPviBuf False
AmpEna False LookAheadActive False
AmpFault False LookAheadChange False
AmpWarn False LookAheadDir Forward
AuxFault False LookfheadFlush False
BlockActive False LookAheadlookBack False
BlockRequest False LockAheadReCalc False
BufferWarn 0 LockAheadStop False
CC3Active False LockAheadWrap False =
CCAddedArc False MinusLimnit False i
CCMode Off MovelMode LineCircle
CCMoveType Dwell PlusLimit False
|| CCOffReq False Proghctive False
| ClosedLoop False ProgProceeding False
ContMotion False ProgRunning False
Csolve False SegEnabled False
DesVelZero False SegMove Off
Encloss False SegMovelccel False
EndDelayActive False SegMoveDecel False B
ErrorStatus MoError SegStopReq False
FeedHeld Off SharpCornerstop False
FeFatal False SoftMinusLimit False
u‘-’am False SoftPlusLimit False
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9. Appendix ECAT]Ji] Structure Elements

The Controller uses motion controller technology developed by Delta Tau Data Systems, Inc.,
(hereafter referred to as DT) in the U.S., however, the ECAT]i] structure elements differ from those of
DT controllers. The following table shows the major changes that have been made from DT
controllers.

Element name Description Change
ECATI[i].Enable Enabling the EtherCAT 0: Disable, 1: Enable
network (2 and 3 are not supported.)
ECATIi].LPIO[K] Elements of low priority Not supported
I/O module
ECATIi].Slave[j] Slave elements Not supported
ECAT]Ji].Error Error code of enabling $ 9811000C: Invalid network
EtherCAT network configuration
$ 9811002E: Disconnected network
connection
ECAT]Ii].LinkUp Status data structure Not supported

ECAT[i].LPDomainOutputState | elements
ECAT[i].LPDomainState
ECAT[i].LPRxTime

ECAT[i].LPTxTime

ECAT[i].MasterStat
ECAT[i].RTDomainOutputState
ECATIi].RTDomainState
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